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Microsoft Word is the world's most popular text document editor. People use Word documents to edit and distribute contracts, articles, legal, and other documents.Microsoft Word allows protecting a file from being opened by unauthorized users. The only person who knows the password can view or modify your file. This protection cannot fully secure
the file from brute-force password attacks, so remember to set complex passwords created by password generators. Microsoft Word supports several levels of protection. You can set the password required to view the document (open the file). You can also set a permission password to restrict specific actions such as editing a document, commenting, or
tracking changes.This free online application based on the GroupDocs API removes the password protection of Microsoft Word files. You have to specify the password to unlock the file. We value your privacy, so the file and the password are visible to you only. You can download the unprotected file to open it. The application works on any device,
including smartphones. Video tutorial Remove password from a wide range of file and document formats including DOCX, PPTX, XLSX, PPT, ZIP, ODP, XLS, DOC, and many more with just a few clicks. Easily upload and unlock your Excel, Word, PowerPoint, and PDF documents directly in your browser, without the need for any additional software.
Access our app from any platform, including Windows, macOS, Android, and iOS, so you can unlock your files anytime, anywhere. Our app operates on our servers, which means you don't need to install any plugins or software to use it. Leverage the power of GroupDocs' document processing API to unlock all of your files quickly and easily. Step 1 Click
inside the file drop area to upload a Word file or drag & drop a Word file. Step 2 Type password and click 'Unlock' button. Step 3 Once your file is unlocked click on 'Download now' button. What is a document protection? Document protection is a security feature that restricts access to files containing sensitive information by requiring a password or
other authentication methods. It adds an extra layer of security when sharing confidential files with colleagues, friends, or clients. How do I open a protected file? To open a protected file, you will need to use the password that was used to lock the file. If you don't know the password, you can try contacting the file owner or the administrator who set up
the password to obtain it. Once you have the password, you can unlock the file and access its contents. How do I remove document protection? To remove document protection, you can use the Unlock app. Upload the file and type the password to save an unprotected file. If you have ever encountered a Word document that is protected and requires a
password to edit, you know how frustrating it can be, especially when you’ve misplaced the password or received a file from someone else without it. Microsoft Word protection can safeguard crucial information or ensure that only authorized users can make changes to a document. Luckily, there are multiple methods available to unprotect a Word
document without the password. Here are five ways to remove password protection and regain access to your file. 1. Save As A Different File Format This method involves converting your protected document into another format such as RTF, TXT, or XML. To do this: - Open the protected Word document. - Click on “File” in the top left corner. - Choose
“Save As” and select a new file format (preferably RTF). - Save the file with a different name. - Close Word and re-open the newly saved document. After following these steps, the protection should no longer apply, allowing you to edit or copy content from the file. 2. Use Google Docs Google Docs offers an easy way to remove protection from Word
documents without requiring any third-party tools or software. - Visit docs.google.com and sign in with your Google account. - Click on the “+” button to create a new document. - In the menu bar, click on “File” and “Open.” - Upload your protected Word document. Once uploaded, Google Docs will likely remove any protection settings automatically;
however, note that some formatting may be altered during this process. 3. Try A Free Online Service There are various online services that promise to unlock password-protected Word documents for free. Be cautious when uploading sensitive documents to such websites. After successful removal of password protection, download your unlocked
document. Assuming the website is trustworthy, this method usually works. 4. Use A Macro Using a simple Visual Basic script, you can unlock the document. Here’s how: - Open your password-protected Word document and press “Alt+F11” to open the Microsoft Visual Basic for Applications editor. - Click “Insert” and then “Module.” - Copy and paste
the following code into the editor: “*vb Sub UnprotectDocument() Dim strPass As String On Error Resume Next For i = 65 To 66 For j = 65 To 66 For k = 65 To 66 For 1 = 65 To 66 For m = 65 To 66 For il = 65 To 66 For i2 = 65 To 66 For i3 = 65 To 66 strPass = Chr(i) & Chr(j) & Chr(k) & Chr(l) & Chr(m) & Chr(il) & Chr(i2) & Chr(i3)
Application.DisplayAlerts = False ActiveDocument.Unprotect strPass If ActiveDocument.ProtectionType = wdNoProtection Then Exit Sub Next i3 Next i2 Next i1 Next m Next 1 Next k Next j Next i End Sub - Press “F5” to run the macro and wait for the script to attempt unlocking your document. If successful, the protection will be removed. 5. Use
Third-Party Software Numerous paid software solutions can unprotect password-protected Word documents, such as PassFab for Word or Elcomsoft Advanced Office Password Recovery. This free app is designed to remove password protection from documents and archives. If you have a password-protected file and want to remove the password so that
access to the content is no longer restricted, then use the Password Remover app. Please note that this is by no means a password hacking tool. It will not help you to brute-force the password or find it out in any other way. You can only remove protection if you know the password. Unprotect a document or archive online To remove password protection
from a document or archive, upload the file and enter the password that was set to restrict access. If the password matches, then the file will be unlocked and all restrictions will be lifted. Right after that, you can save the unlocked file back to your device. You also have the option to save the unlocked file in a different format. All your files and passwords
are completely safe. The security of user data is our top priority. How to unlock a document with a password Upload a document to unlock with a password. Specify a password and press the "UNLOCK" button to remove protection. Download the unlocked document to view or send a link to an email. Output files will be deleted from our servers after 24
hours and download links will stop working. Not likely at all Extremely likely Step 3 of 3 Let's keep in touch about your feedback? If you enter your email, then your question will be automatically posted to Aspose Free Support Forum and reviewed by our specialists. You will receive a detailed answer from the Support Team in the near future. Attach my
files for issue analysis Invalid email: Do you want to continue anyway? Thank you very much for your feedback!We really appreciate it! Our products become better and better everyday with your help! If you enjoy using our application, you can recommend us to your friends and colleagues in social media: , the free encyclopedia that anyone can edit.
107,747 active editors 7,024,400 articles in English Lieutenant-General Henry de Hinuber (1767-1833) was a Hanoverian army officer who commanded units of the King's German Legion (KGL) during the Napoleonic Wars. Initially serving in the Hanoverian Army, in 1782 he fought in the Second Anglo-Mysore War in India. He was present at the siege
of Cuddalore. The French Revolutionary Wars began a decade later and Hinuber served in the Flanders Campaign. When Hanover was invaded in 1803, Hinuber offered his services to the British Army and was given command of the 3rd Line Battalion of the KGL before commanding a brigade in the Bay of Naples in 1809. He was promoted to major-
general in 1811 and given command of a brigade in Lord Wellington's Peninsular War army in 1813. Hinuber commanded his brigade at the Battle of Nivelle in 1813 and then at the siege of Bayonne the following year, when he led the response to the French counter-attack. He joined the army of the new Kingdom of Hanover in 1816. He received his last
command in 1831, of the 2nd Division of a corps of the German Federal Army, and died in Frankfurt two years later. (Full article...) Recently featured: Hurricane Claudette (2003) Trinity (nuclear test) Manitoba Archive By email More featured articles About Glédis Perla Viggdsdottir ... that Glédis Perla Viggdsdottir (pictured) scored two goals for the
Iceland women's national football team the day before she graduated from university? ... that the literary heritage of Nova Scotia includes the first newspaper and the first literary journal in Canada? ... that according to the Zoo Miami communications director, 100 men could beat a single gorilla if they "envelop the gorilla and create a human
straightjacket"? ... that the memorial for James Bunbury White, the founder of Whiteville, North Carolina, was knocked down in a car crash 200 years after his death? ... that before the establishment of Singapore's Rail Test Centre, the bulk of rolling-stock testing had to be conducted overseas? ... that the artist Cady Noland has disavowed artworks that
she no longer considered genuine because they were damaged or altered? ... that Christ Church, Amherstburg, a Canadian church built by a Loyalist, features timbers fashioned after a ship's hull? ... that Li Jinhua was the first female spokesperson of the Chinese Ministry of Foreign Affairs? ... that an announcer damaged the tower of an Arkansas radio
station while driving a moving van? Archive Start a new article Nominate an article Muhammadu Buhari Former president of Nigeria Muhammadu Buhari (pictured) dies at the age of 82. Clashes between Druze militias and the Syrian Armed Forces result in hundreds of deaths. The International Criminal Court issues arrest warrants for Taliban leaders
Hibatullah Akhundzada and Abdul Hakim Haqgani over their alleged persecution of women in Afghanistan. Flooding in Central Texas, United States, leaves at least 140 people dead. Ongoing: Gaza war Russian invasion of Ukraine timeline Sudanese civil war timeline Recent deaths: Felix Baumgartner Fauja Singh Bradley John Murdoch Frank Barrie
Thor Poklad Glen Michael Nominate an article July 18 Nadia Comaneci on the balance beam 1290 - King Edward I issued an edict to expel all Jews from England. 1723 - Johann Sebastian Bach directed the first performance of his cantata Erforsche mich, Gott, und erfahre mein Herz in Leipzig. 1976 - At the Olympic Games in Montreal, Nadia Comaneci
(pictured) became the first person to score a perfect 10 in a modern Olympics gymnastics event. 1989 - American actress Rebecca Schaeffer was shot and killed by Robert John Bardo, eventually prompting the passage of anti-stalking laws in California. 1995 - Selena's album Dreaming of You, instrumental in popularizing Tejano music, was released
posthumously. Benito Juarez (d. 1872)Richard Branson (b. 1950)M.I.A. (b. 1975)Amy Gillett (d. 2005) More anniversaries: July 17 July 18 July 19 Archive By email List of days of the year About Painted bat There are 30 extant kerivouline species, which are members of Kerivoulinae, one of the four subfamilies of Vespertilionidae, itself one of twenty
families of bats in the mammalian order Chiroptera, and part of the microbat suborder. Kerivoulines, or woolly bats, are found in Africa and Asia, primarily in forests and caves, though some species can also be found in grasslands, savannas, or wetlands. They range in size from the least woolly bat, at 2 cm (1 in) plus a 2 cm (1 in) tail, to the Kachin
woolly bat, at 6 cm (2 in) plus a 7 cm (3 in) tail. The 30 extant species of Kerivoulinae are divided between two genera, with 26 species in Kerivoula and the remaining four in Phoniscus. (Full list...) Recently featured: Accolades received by Inception 1956 Summer Olympics medal table Municipalities in Prince Edward Island Archive More featured lists
The Basilica of St Paul is a Catholic parish church in Rabat, Malta, located on the edge of the site of the Roman city of Melite. The present church was built between 1653 and 1658, replacing a church that was completed in 1578. It was constructed with funds from the noblewoman Cosmana Navarra, on plans prepared by Francesco Buonamici. The final
stages were carried out completed by Lorenzo Gafa. It was elevated to the status of a minor basilica in 2020. The church features a grotto where, according to tradition, Paul the Apostle lived and preached during his three-month stay in Malta in AD 60. This photograph shows the facade of the Basilica of St Paul in 2021. Photograph credit: Diego Delso
Recently featured: Clouded Apollo Anne of Cleves Rosencrantz and Guildenstern Archive More featured pictures Community portal - The central hub for editors, with resources, links, tasks, and announcements. Village pump - Forum for discussions about Wikipedia itself, including policies and technical issues. Site news - Sources of news about
Wikipedia and the broader Wikimedia movement. Teahouse - Ask basic questions about using or editing Wikipedia. Help desk - Ask questions about using or editing Wikipedia. Reference desk - Ask research questions about encyclopedic topics. Content portals - A unique way to navigate the encyclopedia. Wikipedia is written by volunteer editors and
hosted by the Wikimedia Foundation, a non-profit organization that also hosts a range of other volunteer projects: CommonsFree media repository MediaWikiWiki software development Meta-WikiWikimedia project coordination WikibooksFree textbooks and manuals WikidataFree knowledge base WikinewsFree-content news WikiquoteCollection of
quotations WikisourceFree-content library WikispeciesDirectory of species WikiversityFree learning tools WikivoyageFree travel guide WiktionaryDictionary and thesaurus This Wikipedia is written in English. Many other Wikipedias are available; some of the largest are listed below. 1,000,000+ articles aw =)l Deutsch Espafiol w6 Francais Italiano
Nederlands H#:E Polski Portugués Pycckuii Svenska Ykpainceka Tiéng Viét 5132 250,000+ articles Bahasa Indonesia Bahasa Melayu Ban-lam-gt Beirapcku Catala Cestina Dansk Eesti EAAnviké Esperanto Euskara nnay Quytintit Magyar Norsk bokmal Roméana Simple English Slovenéina Srpski Srpskohrvatski Suomi Tiirkce O‘zbekcha 50,000+ articles
Asturianu Azsrbaycanca (0000 Bosanski s»,¢S Frysk Gaeilge Galego Hrvatski Jo®omgeo Kurdi Latviesu Lietuviu Q00000 Makemorcku (000000000 Norsk nynorsk 000000 Shaip Slovenséina 00 000000 s»,! Retrieved from " 2 This article needs additional citations for verification. Please help improve this article by adding citations to reliable sources. Unsourtc
material may be challenged and removed.Find sources: "1290" - news - newspapers - books - scholar - JSTOR (August 2017) (Learn how and when to remove this message) Calendar year Years Millennium 2nd millennium Centuries 12th century 13th century 14th century Decades 1270s 1280s 1290s 1300s 1310s Years 1287 1288 1289 1290 1291 1292
1293 vte 1290 by topic Leaders Political entities State leaders Religious leaders Birth and death categories Births - Deaths Establishments and disestablishments categories Establishments - Disestablishments Art and literature 1290 in poetry vte 1290 in various calendarsGregorian calendar1290MCCXCAb urbe condita2043Armenian calendar739(3L
QL(3Assyrian calendar6040Balinese saka calendar1211-1212Bengali calendar696-697Berber calendar2240English Regnal year18 Edw. 1 - 19 Edw. 1Buddhist calendar1834Burmese calendar652Byzantine calendar6798-6799Chinese calendarc2 A& (Earth Ox)3987 or 3780 — to —FRESF (Metal Tiger)3988 or 3781Coptic calendar1006-1007Discordian
calendar2456Ethiopian calendar1282-1283Hebrew calendar5050-5051Hindu calendars - Vikram Samvat1346-1347 - Shaka Samvat1211-1212 - Kali Yuga4390-4391Holocene calendar11290Igbo calendar290-291Iranian calendar668-669Islamic calendar688-689Japanese calendarShoo 3(1Ei 3 £)Javanese calendar1200-1201]Julian
calendar1290MCCXCKorean calendar3623Minguo calendar622 before ROCEK#16225 Nanakshahi calendar—178Thai solar calendar1832-1833Tibetan calendar[0000000000(female Earth-Ox)1416 or 1035 or 263 — to —J00000000000000(male Iron-Tiger)1417 or 1036 or 264 King Andrew III (r. 1290-1301) Year 1290 (MCCXC) was a common year
starting on Sunday of the Julian calendar. July 10 - King Ladislaus IV of Hungary ("the Cuman") is assassinated at the castle of Kérosszeg (modern Romania). He is succeeded by Andrew III ("the Venetian"), after an election by Hungarian nobles, who is crowned by Archbishop Lodomer as new ruler of Hungary and Croatia in Székesfehérvar on July 23.[1]
[2] December 18 - King Magnus III of Sweden ("Birgersson") dies after a 15-year reign. He is succeeded by his 10-year-old son Birger ("Magnusson"). Although, Sweden is an elective monarchy, Birger had already been appointed heir to the throne in 1284. July 18 - Edict of Expulsion: King Edward I of England ("Longshanks") orders all Jews (at this time
probably numbering around 2,000) to leave the country by November 1 (All Saints' Day[3]). The edict was decreed on Tisha B'Av on the Hebrew calendar, a day that commemorates many calamities. They are eventually allowed back in 1656. September - The 7-year-old Margaret, Maid of Norway, queen-designate and heir to the crown of Scotland, dies
en route to the British Isles in Orkney, leading to thirteen competitors for the crown of Scotland, a succession crisis. November 28 - Eleanor of Castile, wife of Edward I, dies while traveling in the North. She has been suffering from illness for some time, and the cold and dampness of the winter months probably aggravate her condition. December -
Edward I travels with the body of Queen Eleanor from Lincoln to London. Remembering his wife, Edward erects a series of crosses at each location that the body rests overnight. These are known as the twelve Eleanor crosses. Winter - The second of the Statutes of Mortmain passed during the reign of Edward I prevents land from passing into the
possession of the Church. Quia Emptores, a statute passed by Edward I, puts an end to the practice of subinfeudations. The statute allows land to be sold according to royal approval, as long as the new owner answers directly to his lord or the king. June - Genoa concludes a new commercial treaty with the Mamluks; five galleys sent by King James II of
Aragon ("the Just") join the Venetian Crusader fleet (some 20 ships) on its way to Acre. On board the fleet are Italian urban militias and mercenary forces under Seneschal Jean I de Grailly, who have fought for the Papal States in the so-called Italian Crusades.[4] August - Italian Crusaders massacre Muslim merchants and peasants, and some local
Christians in Acre. Some claim it began at a drunken party - others that a European husband found his wife making love to a Muslim. The barons and local knights try to rescue a few Muslims and take them to the safety of the castle, while some ringleaders are arrested.[5] August 30 - Survivors and relatives of the massacre at Acre take bloodstained
clothing to Sultan Qalawun ("the Victorious") in Cairo, who demands that the leaders of the riot be handed over for trial, but the nobles refuse to send them and Qalawun now obtains legal clearance from the religious authorities in Cairo to break the truce with Crusader states.[6] October - Qalawun orders a general mobilization of the Mamluk forces. In
a council, it is decided that a peace delegation be sent to Cairo under Guillaume de Beaujeu, Grand Master of the Knights Templar. However, Qalawun demands huge compensation for those killed in Acre, and sends a Syrian army to the coast of Palestine, near Caesarea.[7] November 10 - Qalawun ("the Victorious") dies as the Egyptian Mamluk army
sets out for Acre. He is succeeded by his eldest son Al-Ashraf Khalil as ruler of the Mamluk Sultanate. Khalil orders his allies and tributaries in Syria to prepare for a campaign next spring. Governors and castle commanders are ordered to assemble siege equipment and armor.[8] June 13 - Shamsuddin Kayumars, Mamluk ruler of the Delhi Sultanate, is
murdered and succeeded by Jalal-ud-din Khalji (or Firuz Shah I), founder of the Khalji dynasty, ending Mamluk rule and instigating the Khalji Revolution.[9] September 27 - The 6.8 Ms Zhili earthquake affects the province of Zhili in China, with a maximum Mercalli intensity of IX (Violent), killing 7,270-100,000 people. June 8 - Beatrice Portinari, muse
of the Italian poet Dante Alighieri, dies in Florence. In his Divine Comedy (La Divina Commedia), he transforms his memory of Beatrice into an allegory of divine love.[10] "Year without winter" - An exceptionally rare instance of uninterrupted transition, from autumn to the following spring, in England and the mainland of Western Europe.[11] March 1 -
The University of Coimbra is founded in Lisbon by Denis I ("the Poet King"). He decrees that Portuguese is the official language of Portugal, replacing classical Latin in that capacity. The Dnyaneshwari is written in India. This holy book is a commentary on the Bhagvad Gita and is narrated by Dnyaneshwar. January 3 - Constance of Portugal, queen
consort of Castile (d. 1313) January 6 - Otto Bodrugan, English landowner and politician (d. 1331) June 23 - Jakushitsu Genko, Japanese Rinzai master and poet (d. 1367) August 4 - Leopold I, Duke of Austria ("the Glorious"), German nobleman (d. 1326) October 15 - Anne of Bohemia, queen consort of Bohemia (d. 1313) December 24 - Khwaju Kermani,
Persian poet and mystic (d. 1349) Agnes Haakonsdatter, Norwegian noblewoman and princess (d. 1319) Andrea Pisano (or Pontedera), Italian sculptor and architect (d. 1348) Barlaam of Seminara, Italian cleric, scholar and theologian (d. 1348) Beatrice of Silesia, queen of Germany (House of Piast) (d. 1322) Buton Rinchen Drub, Tibetan Buddhist
religious leader (d. 1364) Daichi Sokei, Japanese Buddhist monk, disciple and poet (d. 1366) Giovanni Visconti, Italian cardinal, archbishop and co-ruler (d. 1354) Guido Gonzaga, Italian nobleman and knight (condottiero) (d. 1369) Hugues Quiéret, French nobleman, admiral and advisor (d. 1340) Jacob van Artevelde, Flemish merchant and statesman (d.
1345) Jacopo Dondi dell'Orologio, Italian doctor and polymath (d. 1359) Johannes de Muris, French mathematician and astronomer (d. 1344) John Maltravers, English nobleman, knight and governor (d. 1364) John Parricida, German nobleman (House of Habsburg) (d. 1312) Jyotirishwar Thakur, Indian playwright, poet and writer (d. 1350) Ke Jiusi,
Chinese landscape painter and calligrapher (d. 1343) Kitabatake Tomoyuki, Japanese nobleman and poet (d. 1332) Kujo Fusazane, Japanese nobleman, official and regent (d. 1327) Peter of Castile, Lord of Cameros, Spanish nobleman and prince (infante) (d. 1319) Pierre Bersuire (or Bercheure), French translator and encyclopaedist (d. 1362) Rabbenu
Yerucham, French rabbi and scholar (posek) (d. 1350) Richard de Willoughby, English landowner and politician (d. 1362) Rudolf Hesso, Margrave of Baden-Baden, German nobleman (House of Zahringen) (d. 1335) Sesson Yubai, Japanese Buddhist monk, priest and poet (d. 1347) Theodore I, Marquis of Montferrat ("Palaiologos"), Byzantine nobleman
and writer (d. 1338) Willem van Duvenvoorde, Dutch nobleman and knight (d. 1353) January 28 - Dervorguilla of Galloway, Scottish noblewoman (b. 1210) February 3 - Henry XIII, Duke of Bavaria, German nobleman, co-ruler and knight (b. 1235) March 24 - John dal Bastone, Italian monk, priest and preacher (b. 1200) March 26 - John Kirkby, English
bishop, vice-chancellor and statesman April 26 - Gaston VII, Viscount of Béarn ("Froissard"), French nobleman and knight (b. 1225) May 10 - Rudolf II, Duke of Austria, German nobleman (House of Habsburg) (b. 1270) June 8 - Beatrice Portinari, Italian muse of Dante (b. 1266) June 13 - Shamsuddin II, Mamluk ruler of the Delhi Sultanate (b. 1285) June
23 - Henryk IV Probus ("the Righteous"), High Duke of Poland (b. 1258) July 10 - Ladislaus IV ("the Cuman"), king of Hungary and Croatia (b. 1262) September 26 - Margaret, Maid of Norway, queen of Scotland (b. 1283) November 10 - Qalawun ("the Victorious"), Mamluk ruler of Egypt (b. 1222) November 28 - Eleanor of Castile, queen consort of
England (b. 1241) December 18 Herman I, German nobleman (House of Henneberg) (b. 1224) Magnus III (or I) ("Birgersson"), king of Sweden (b. 1240) December 21 - Gerhard I, Count of Holstein-Itzehoe, German nobleman, knight and regent (b. 1232) Adelaide, Countess of Auxerre, French noblewoman and ruler (suo jure) (b. 1251) Alice de Lusignan,
Countess of Gloucester, French noblewoman (House of Lusignan) (b. 1236) Cecilia Cesarini (or Caecilia), Italian noblewoman and nun (b. 1203) Eison, Japanese Buddhist scholar-monk, disciple and priest (b. 1201) Elizabeth the Cuman, queen of Hungary (House of Arpad) (b. 1244) Fakhr al-Din Mustawfi, Persian finance minister, advisor and vizier ©
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hundred years, from 1101 to 1200 See also: Renaissance of the 12th century Millennia 2nd millennium Centuries 11th century 12th century 13th century Timelines 11th century 12th century 13th century State leaders 11th century 12th century 13th century Decades 1100s 1110s 1120s 1130s 1140s 1150s 1160s 1170s 1180s 1190s Categories: Births -
Deaths Establishments - Disestablishments vte Eastern Hemisphere at the beginning of the 12th century The 12th century is the period from 1101 to 1200 in accordance with the Julian calendar. In the history of European culture, this period is considered part of the High Middle Ages and overlaps with what is often called the "'Golden Age' of the
Cistercians". The Golden Age of Islam experienced significant development, particularly in Islamic Spain. In Song dynasty China, an invasion by Jurchens caused a political schism of north and south. The Khmer Empire of Cambodia flourished during this century, while the Fatimids of Egypt were overtaken by the Ayyubid dynasty. Following the
expansions of the Ghaznavids and Ghurid Empire, the Muslim conquests in the Indian subcontinent took place at the end of the century. Main article: 1100s The Ghurid Empire converted to Islam from Buddhism. 1101: In July, the Treaty of Alton is signed between Henry I of England and his older brother Robert, Duke of Normandy in which Robert
agrees to recognize Henry as king of England in exchange for a yearly stipend and other concessions. The agreement temporarily ends a crisis in the succession of the Anglo-Norman kings. 1101-1103: David the Builder takes over Kakheti and Hereti (now parts of Georgia). 1102: King Coloman unites Hungary and Croatia under the Hungarian Crown.
1102: Muslims conquer Seforio de Valencia. 1103-1104: A church council is convened by King David the Builder in Urbnisi to reorganize the Georgian Orthodox Church. 1104: In the Battle of Ertsukhi, King David the Builder defeats an army of Seljuks. 1104: King Jayawarsa of Kadiri (on Java) ascends to the throne.[citation needed] 1106: Battle of
Tinchebray. 1107-1111: Sigurd I of Norway becomes the first Norwegian king to embark on a crusade to the Holy Land. He fights in Lisbon and on various Mediterranean isles and helps the King of Jerusalem to take Sidon from the Muslims. 1108: By the Treaty of Devol, signed in September, Bohemond I of Antioch has to submit to the Byzantine
Empire, becoming the vassal of Alexius I. 1109: On June 10, Bertrand of Toulouse captures the County of Tripoli (northern Lebanon/western Syria). 1109: In the Battle of Naklo, Boleslaus III Wrymouth defeats the Pomeranians and re-establishes Polish access to the sea. 1109: On August 24, in the Battle of Hundsfeld, Boleslaus III Wrymouth defeats
Emperor Henry V of Germany and stops German expansion eastward. Main article: 1110s 1111: On April 14, during Henry V's first expedition to Rome, he is crowned Holy Roman Emperor. 1113: Paramavishnulok is crowned as King Suryavarman II in Cambodia. He expands the Khmer Empire and builds Angkor Wat during the first half of the century.
He establishes diplomatic relations with China. 1115: The Georgian army occupies Rustavi in the war with the Muslims. 1115: In Java, King Kamesvara of Kadiri ascends to the throne. Janggala ceases to exist and comes under Kadiri domination, highly possible under royal marriage. During his reign, Mpu Dharmaja writes Kakawin Smaradahana, a
eulogy for the king which become the inspiration for the Panji cycle tales, which spread across Southeast Asia.[1] 1116: The Byzantine army defeats the Turks at Philomelion. 1116: Death of dofia Jimena Diaz, governor of Valencia from 1099 to 1102. c. 1119: The Knights Templar are founded to protect Christian pilgrims in Jerusalem. Main article: 1120s
A Black and White Photo of the 12th century Cuenca Cathedral (built from 1182 to 1270) in Cuenca, Spain 1120: On January 16, the Council of Nablus, a council of ecclesiastic and secular lords in the crusader Kingdom of Jerusalem, establishes the first written laws for the kingdom. 1120: On November 25, William Adelin, the only legitimate son of King
Henry I of England, drowns in the White Ship Disaster, leading to a succession crisis which will bring down the Norman monarchy of England. 1121: On August 12, in the Battle of Didgori, the greatest military victory in Georgian history, King David the Builder with 45,000 Georgians, 15,000 Kipchak auxiliaries, 500 Alan mercenaries and 100 French
Crusaders defeats a much larger Seljuk-led Muslim coalition army. 1121: On December 25, St. Norbert and 29 companions make their solemn vows in Premontre, France, establishing the Premonstratensian Order. 1122: The Battle of Beroia (Modern-day Stara Zagora, Bulgaria) results in the disappearance of the Pechenegs Turkish tribe as an
independent force. 1122: On September 23, the Concordat of Worms (Pactum Calixtinum) is drawn up between Emperor Henry V and Pope Calixtus II bringing an end to the first phase of the power struggle between the papacy and the Holy Roman Empire. 1122: King David the Builder captures Thilisi and declares it the capital city of Georgia, ending
400 years of Arab rule. 1123: The Jurchen dynasty of China forces Koryo (now Korea) to recognize their suzerainty. 1124: In April or May, David I is crowned King of the Scots. 1125: On June 11, in the Battle of Azaz, the Crusader states, led by King Baldwin II of Jerusalem, defeat the Seljuk Turks. 1125: In November, the Jurchens of the Jin dynasty
declare war on the Song dynasty, beginning the Jin-Song wars. 1125: Lothair of Supplinburg, duke of Saxony, is elected Holy Roman Emperor instead of the nearest heir, Frederick of Swabia, beginning the great struggle between Guelphs and Ghibellines. 1127: The Northern Song dynasty loses power over northern China to the Jin dynasty. 1128: On
June 24, the Kingdom of Portugal gains independence from the Kingdom of Ledn at the Battle of Sdo Mamede; (recognised by Ledn in 1143). Main article: 1130s The temple complex of Angkor Wat, built during the reign of Suryavarman II in Cambodia of the Khmer Era. 1130-1180: 50-year drought in what is now the American Southwest. 1130-1138:
Papal schism, Pope Innocent II vs. Antipope Anacletus II. 1130: On March 26, Sigurd I of Norway dies. A golden era of 95 years comes to an end for Norway as civil wars between the members of Harald Fairhair's family line rage for the remainder of the century. 1130: On Christmas Day, Roger II is crowned King of Sicily, the royal title being bestowed
on him by Antipope Anacletus II. 1132: The Southern Song dynasty establishes China's first permanent standing navy, although China had a long naval history prior. The main admiral's office is at the port of Dinghai. 1132-1183: the Chinese navy increases from a mere 3,000 to 52,000 marine soldiers stationed in 20 different squadrons. During this time,
hundreds of treadmill-operated paddle wheel craft are assembled for the navy to fight the Jin dynasty in the north. 1135: King Jayabaya of Kadiri ascends to the throne.[2] 1135-1154: The Anarchy takes place, during a period of civil war in England. 1136: Suger begins rebuilding the abbey church at St Denis north of Paris, which is regarded as the first
major Gothic building. 1137: On July 22, the future King Louis VII of France marries Eleanor, the Duchess of Aquitaine. 1138: On October 11, the 1138 Aleppo earthquake devastates much of northern Syria. 1139: in April, the Second Lateran Council ends the papal schism. 1139: On July 5, in the Treaty of Mignano, Pope Innocent II confirms Roger II as
King of Sicily, Duke of Apulia, and Prince of Capua and invests him with his titles. 1139: On July 25, the Portuguese defeat the Almoravids led by Ali ibn Yusuf in the Battle of Ourique; Prince Afonso Henriques is acclaimed King of Portugal by his soldiers. Main article: 1140s Averroes in a 14th-century painting by Andrea di Bonaiuto 1140-1150: Collapse
of the Ancestral Puebloan culture at Chaco Canyon (modern-day New Mexico). 1141: The Treaty of Shaoxing ends the conflict between the Jin dynasty and Southern Song dynasty, legally establishing the boundaries of the two countries and forcing the Song dynasty to renounce all claims to its former territories north of the Huai River. The treaty
reduces the Southern Song into a quasi-tributary state of the Jurchen Jin dynasty. 1143: Manuel I Komnenos is crowned as Byzantine emperor after the death of John II Komnenos. 1143: Afonso Henriques is proclaimed King of Portugal by the cortes. 1143: The Treaty of Zamora recognizes Portuguese independence from the Kingdom of Ledn. Portugal
also recognizes the suzerainty of the pope. 1144: On December 24, Edessa falls to the Atabeg Zengi. 1145-1148: The Second Crusade is launched in response to the fall of the County of Edessa. 1147: On October 25, the four-month-long Siege of Lisbon successfully brings the city under definitive Portuguese control, expelling the Moorish overlords.
1147: A new Berber dynasty, the Almohads, led by Emir Abd al-Mu'min, takes North Africa from the Almoravides and soon invades the Iberian Peninsula. The Almohads began as a religious movement to rid Islam of impurities. 1147: The Wendish Crusade against the Polabian Slavs (or "Wends") in what is now northern and eastern Germany. Main
article: 1150s 1150: Ramon Berenguer IV, Count of Barcelona marries Petronilla, the Queen of Aragon. 1151: The Treaty of Tudilén is signed by Alfonso VII of Leén and Raymond Berengar IV, Count of Barcelona, recognizing the Aragonese conquests south of the Jucar and the right to expand in and annex the Kingdom of Murcia. 1153: The Treaty of
Wallingford, ends the civil war between Empress Matilda and her cousin King Stephen of England fought over the English crown. Stephen acknowledges Matilda's son Henry of Anjou as heir. 1153: The First Treaty of Constance is signed between Emperor Frederick I and Pope Eugene III, by the terms of which, the emperor is to prevent any action by
Manuel I Comnenus to reestablish the Byzantine Empire on Italian soil and to assist the pope against his enemies in revolt in Rome. 1154: the Moroccan-born Muslim geographer Muhammad al-Idrisi publishes his Geography. 1154: On December 27, Henry II is crowned King of England at Westminster Abbey. 1155: Pope Adrian IV grants overlordship of
Ireland to Henry II of England in the bull Laudabiliter. 1156: On June 18, the Treaty of Benevento is entered into by Pope Adrian IV and the Norman Kingdom of Sicily. After years of turbulent relations, the popes finally settles down to peace with the Hauteville kings. The kingship of William I is recognized over all Sicily, Apulia, Calabria, Campania, and
Capua. The tribute to the pope of 600 schifati agreed upon by Roger II in 1139 at Mignano is affirmed and another 400 shift is added for the new lands. 1158: The Treaty of Sahagtin ends the war between Castile and Ledn. Main article: 1160s The Liuhe Pagoda of Hangzhou, China, 1165 1161: the Song dynasty Chinese navy, employing gunpowder
bombs launched from trebuchets, defeats the enormous Jin dynasty navy in the East China Sea in the Battle of Tangdao and on the Yangtze River in the Battle of Caishi. 1161: Kilij Arslan II, Sultan of Rum, makes peace with the Byzantine Empire, recognizing the emperor's primacy. 1161: In the siege of Ani, troops from the Kingdom of Georgia take
control over the city, only to have it sold for the second time to the Shaddadids, a Kurdish dynasty. 1162: Genghis Khan, the founder of the Mongol Empire, is born as Temiijin in present-day Mongolia. 1163: The Norwegian Law of Succession takes effect. 1165-1182: Tensions and disputes between the Pagan Empire and the Kingdom of Polonnaruwa
causes the Sinhalese under Parakramabahu the Great to raid Burma. 1168: King Valdemar I of Denmark conquers Arkona on the Island of Riigen, the strongest pagan fortress and temple in northern Europe. 1169: Political disputes within the Pandya Empire sparks the decade-long Pandyan Civil War. 1169: On May 1, the Norman invasion of Ireland
begins. Richard fitzGilbert de Clare (‘'Strongbow') allies with the exiled Irish chief, Dermot MacMurrough, to help him recover his kingdom of Leinster. Main article: 1170s The defense of the Carroccio during the battle of Legnano (1176) by Amos Cassioli (1832-1891) 1170: The Treaty of Sahagun is signed by Alfonso VIII of Castile and Alfonso II of
Aragon. Based on the terms of the accord, Alfonso VIII agrees to provide Alfonso II with three hostages, to be used as tribute payments owed by Ibn Mardani$ of Valencia and Murcia. 1170: On December 29, Thomas Becket is murdered in Canterbury Cathedral. 1171: Saladin deposes the last Fatimid Caliph Al-'Adid and establishes the Ayyubid dynasty.
1171: On November 11, Henry II of England lands in Ireland to assert his claim as Lord of Ireland. 1172: The Pandyan city of Madurai is sacked by the Sinhalese army due to an attempt to drive off the rival throne claimant, Kulasekara Pandyan. 1173: Sinhalese king Parakramabahu the Great gains a decisive victory by invading the Chola Empire as an
ally of the Pandyas in the Pandyan Civil War. 1174: On July 12, William I of Scotland is captured by the English in the Battle of Alnwick. He accepts the feudal overlordship of the English crown and pays ceremonial allegiance at York. 1175: Honen Shonin (Genku) founds the Jodo shii (Pure Land) sect of Buddhism. 1175: The Treaty of Windsor is signed by
King Henry II of England and the High King of Ireland, Ruaidri Ua Conchobair. 1176: On May 29, Frederick Barbarossa's forces are defeated in the Battle of Legnano by the Lombard League which results in the emperor's acknowledgment of the pope's sovereignty over the Papal States and Alexander acknowledging the emperor's overlordship of the
imperial Church. 1176: On September 17, The Battle of Myriokephalon (Myriocephalum; Turkish: Miryakefalon Savasi) is fought between the Byzantine Empire and the Seljuk Turks in Phrygia. It is a serious reversal for the Byzantine forces and will be the final, unsuccessful, effort by the Byzantines to recover the interior of Anatolia from the Seljuk
Turks. 1177: The Treaty or Peace of Venice is signed by the papacy and its allies, and Frederick I, Holy Roman Emperor. The Norman Kingdom of Sicily also participates in negotiations and the treaty thereby determines the political course of all of Italy for the next several years. 1178: Chinese writer Zhou Qufei, a Guangzhou customs officer, writes of
an island far west in the Indian Ocean (possibly Madagascar), from where people with skin "as black as lacquer" and with frizzy hair were captured and purchased as slaves by Arab merchants. 1179: The Treaty of Cazola (Cazorla) is signed by Alfonso II of Aragon and Alfonso VIII of Castile, dividing Andalusia into separate zones of conquest for the two
kingdoms, so that the work of the Reconquista would not be stymied by internecine feuding. Main article: 1180s 1180: The Portuguese Navy defeats a Muslim fleet off the coast of Cape Espichel. 1180-1185: the Genpei War in Japan. 1181: Parakramabahu the Great conducts a large-scale raid on Burma, after a ship transporting a Sinhalese princess to
the Khmer Empire is attacked by Burmese naval fleets. 1182: Religious reformations of Theravada Buddhism in Pagan Burma under the patronage of Narapatisithu are continued with the end of the Polonnaruwa-Pagan War. 1182: Revolt of the people of Constantinople against the Latins, whom they massacre, proclaiming Andronicus I Comnenus as co-
emperor. 1183: On January 25, the final Peace of Constance between Frederick Barbarossa, the pope and the Lombard towns is signed, confirming the Peace of Venice of 1177. 1183: On September 24, Andronicus I Comnenus has his nephew Alexius II Comnenus strangled. 1184: On March 24, Queen Tamar, King of Georgia, accedes to the throne as
sole ruler after reigning with her father, George III, for six years. 1184: Diet of Pentecost organised by Emperor Frederick I in Mainz. 1185: The Uprising of Asen and Peter against the Byzantine Empire leads to the restoration of the Bulgarian Empire. 1185: Andronicus I Comnenus is deposed and, on September 12, executed as a result of the Norman
massacre of the Greeks of Thessalonika. 1185: The cathedral school (Katedralskolan) in Lund, Sweden, is founded. The school is the oldest in northern Europe and one of the oldest in all of Europe. 1185: Beginning in this year the Kamakura shogunate deprives the emperor of Japan of political power. 1186: On January 27, the future Holy Roman
Emperor Henry VI marries Constance of Sicily, the heiress to the Sicilian throne. 1187: On July 4, in the Battle of Hattin, Saladin defeats the king of Jerusalem. 1187: In August, the Swedish royal and commercial center Sigtuna is attacked by raiders from Karelia, Couronia, and/or Estonia.[3] 1188: The Riah were introduced into the Habt and south of
Tetouan by the Almohad caliph, Abu Yusuf Yaqub al-Mansur, and Jochem and Acem were introduced in Tamesna.[4] 1189: On September 3, Richard I is crowned King of England at Westminster. 1189: On November 11, William II of Sicily dies and is succeeded by his illegitimate cousin Tancred, Count of Lecce instead of Constance. 1189-1192: The Third
Crusade is an attempt by European leaders to wrest the Holy Land from Saladin. Main articles: 1190s and 1200s Richard I of England, or Richard the Lionheart. 1190: On June 10, Emperor Frederick Barbarossa drowns in the River Salef, leaving the Crusader army under the command of the rivals Philip II of France and Richard I of England, which
ultimately leads to the dissolution of the army. 1191: Holy Roman Emperor Henry VI attacked the Kingdom of Sicily from May to August but fails and withdrawn, with Empress Constance captured (released 1192). 1191: On September 7, Saladin is defeated by Richard I of England at the Battle of Arsuf. 1192: In April, Isabella I begins her reign as
Christian Queen of the Kingdom of Jerusalem 1192: In the Battle of Jaffa, King Richard the Lionheart defeats Saladin. 1192: In June, the Treaty of Ramla is signed by Saladin and Richard Lionheart. Under the terms of the agreement, Jerusalem will remain under Muslim control. However, the city will be open to Christian pilgrims. The Latin Kingdom is
reduced to a coastal strip that extends from Tyre to Jaffa. 1192: Minamoto no Yoritomo is appointed Sei-i Taishogun, "barbarian-subduing great general", shogun for short, the first military dictator to bear this title. 1192: Sultan Shahabuddin Muhammad Ghori establishes the first Muslim empire in India for 14 years (1192-1206) by defeating Prithviraj
Chauhan. 1193: Nalanda, the great Indian Buddhist educational centre, is destroyed. 1194: Emperor Henry VI conquers the Kingdom of Sicily. 1195: On June 16, the struggle of Shamqori. Georgian forces annihilate the army of Abu Baqar. 1198: The brethren of the Crusader hospital in Acre are raised to a military order of knights, the Teutonic Knights,
formally known as the Order of the Knights of the Hospital of St. Mary of the Teutons in Jerusalem. 1199: Pope Innocent III writes to Kaloyan, inviting him to unite the Bulgarian Church with the Roman Catholic Church. 1200: Construction begins on the Grand Village of the Natchez near Natchez, Mississippi. This ceremonial center for the Natchez
people is occupied and built until the early 17th century.[5] Eastern Hemisphere at the end of the 12th century China is under the Northern Song dynasty. Early in the century, Zhang Zeduan paints Along the River During the Qingming Festival. It will later end up in the Palace Museum, Beijing. In southeast Asia, there is conflict between the Khmer

Europe undergoes the Renaissance of the 12th century. The blast furnace for the smelting of cast iron is imported from China, appearing around Lapphyttan, Sweden, as early as 1150. Alexander Neckam is the first European to document the mariner's compass, first documented by Shen Kuo during the previous century. Christian humanism becomes a
self-conscious philosophical tendency in Europe. Christianity is also introduced to Estonia, Finland, and Karelia. The first medieval universities are founded. Pierre Abelard teaches. Middle English begins to develop, and literacy begins to spread outside the Church throughout Europe.[6] In addition, churchmen are increasingly willing to take on secular
roles. By the end of the century, at least a third of England's bishops also act as royal judges in secular matters.[7] The Ars antiqua period in the history of the medieval music of Western Europe begins. The earliest recorded miracle play is performed in Dunstable, England. Gothic architecture and trouvére music begin in France. During the middle of
the century, the Cappella Palatina is built in Palermo, Sicily, and the Madrid Skylitzes manuscript illustrates the Synopsis of Histories by John Skylitzes. Fire and plague insurance first become available in Iceland, and the first documented outbreaks of influenza there happens. The medieval state of Serbia is formed by Stefan Nemanja and then
continued by the Nemanji¢ dynasty. By the end of the century, both the Capetian dynasty and the House of Anjou are relying primarily on mercenaries in their militaries. Paid soldiers are available year-round, unlike knights who expected certain periods off to maintain their manor lifestyles.[8] In India, Hoysala architecture reaches its peak. In the
Middle East, the icon of Theotokos of Vladimir is painted probably in Constantinople. Everything but the faces will later be retouched, and the icon will go to the Tretyakov Gallery of Moscow. The Georgian poet Shota Rustaveli composes his epic poem The Knight in the Panther's Skin. Shahab al-Din Suhrawardi founds his "school of illumination". In
North Africa, the kasbah of Marrakesh is built, including the city gate Bab Agnaou and the Koutoubia mosque. In sub-Saharan Africa, Kente cloth is first woven. In France, the first piedfort coins were minted. The city of Tula burns down, marking the end of the Toltec Empire In West Africa the Ife Empire is established. See also: Timeline of historic
inventions § 12th century 1104: The Venice Arsenal of Venice, Italy, is founded. It employed some 16,000 people for the mass production of sailing ships in large assembly lines, hundreds of years before the Industrial Revolution. 1106: Finished building of Gelati. 1107: The Chinese engineer Wu Deren combines the mechanical compass vehicle of the
south-pointing chariot with the distance-measuring odometer device. 1111: The Chinese Donglin Academy is founded. 1165: The Liuhe Pagoda of Hangzhou, China, is built. 1170: The Roman Catholic notion of Purgatory is defined.[9] 1185: First record of windmills. Wikimedia Commons has media related to 12th century. ©~ Soekmono, R, Drs., Pengantar
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Ismaél Hamet. p. 248. ~ Francine Weiss and Mark R. Barnes (May 3, 1989). "National Register of Historic Places Registration: Grand Village of the Natchez Site / Fatherland Plantation Site (22-Ad-501)" (pdf). National Park Service. and Accompanying 3 photos, from 1989. (680 KB) ™~ Warren 1961, p. 129. ™ Warren 1961, p. 159. ™~ Warren 1961, p. 60-
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Info Protect Document Encrypt with Password. Clear the password in the Password box, and then click OK. Heres how to remove any editing restrictions youve placed on a Microsoft Word document: Open the document and click on the Review tab. Under Protect, select Restrict editing to view the current editing permissions. Click Stop Protection. If you
chose password protection, enter the password when prompted. Unlock a protected document If you are an authenticated owner of the document, or if you know the password for removing document protection, do the following: On the Review tab, in the Protect group, click Restrict Editing. In the Restrict Editing task pane, click Stop Protection. Unlock
a protected document On the Review tab, in the Protect group, click Restrict Editing. In the Restrict Editing task pane, click Stop Protection. If you are prompted to provide a password, type the password. 1. Select File Info Protect Document. 2. Select Always open Read-Only. Removing the Password of a Full Locked Word Document Step 1: Open your
Word document and enter its password. Step 2: Click on File Info Protect Document Encrypt with Password. Step 3: Delete the password in the Password box, and then click OK. Great solution for PDF docs with very little pre-knowledge required. "Simplicity, familiarity with the menu and user-friendly. It's easy to navigate, make changes and edit
whatever you may need. Because it's used alongside Google, the document is always saved, so you don't have to worry about it." A Valuable Document Signer for Small Businesses. "I love that DocHub is incredibly affordable and customizable. It truly does everything I need it to do, without a large price tag like some of its more well known competitors. I
am able to send secure documents directly to me clients emails and via in real time when they are viewing and making alterations to a document." I can create refillable copies for the templates that I select and then I can publish those. "I like to work and organize my work in the appropriate way to meet and even exceed the demands that are made daily
in the office, so I enjoy working with PDF files, I think they are more professional and versatile, they allow..." be ready to get more Get started now Remove password in docx free remove word document protection without password remove protection from word document without password online unlock docx file online word password remover word
password recovery master remove password from word document mac remove protection from word document online © 2025 DocHub, LLC The features of Word let us create high-quality documents and protect our files with passwords. Although passwords are helpful and provide an extra security layer, entering a password every time you open a file
could be annoying, especially when your Word documents are no longer classified as confidential. Besides, you could still lose or forget the password. Keep reading as we teach you how to remove password from a Word document. Part 1. Two Primary Ways of Word Password Protection Before removing the password from a word document, you should
know how it is locked. Microsoft provides two ways of Word password protection: Full document lock and Restrict Editing. Full Document Lock Microsoft Word lets you encrypt documents with a password to prevent unauthorized people from opening them. You can go through File > Info > Protect document > Encrypt with Password to enable Word full
document password protection. Afterwards, Word will prompt you and other people to enter the password to open the document. Make sure to write an elaborate but unforgettable password, as Word doesn't let you recover or remove the password if you forget it. Restrict Editing You can make sure no one will be able to edit your document without
entering the password by activating the Restrict Editing feature. Step 1: Go through File > Info > Protect document > Restrict Editing, and you will see the Restrict Editing panel on the right. Step 2: Check the Allow only this type of Editing in the document and choose No change (Read only) in the drop-down list. Click the Yes, Start Enforcing
Protection button. Step 3: The Start Enforcing Protection window will pop up. Choose Password under the Protection method and enter your password. Click OK. Step 4: Finally, save your change and re-open the Word document. MS Word will prompt you to enter the password when you try to edit the document. Part 2. How to Remove Password
Protection of a Word Document When You Know the Password It's simple to remove the password protection of your word document if you already know the password. Removing the Password of a Full Locked Word Document Step 1: Open your Word document and enter its password. Step 2: Click on File > Info > Protect Document > Encrypt with
Password. Step 3: Delete the password in the Password box, and then click OK. Removing the Word Password of Editing Restriction Step 1: Open the password-protected Word file. Step 2: Go to Review > Protect > Restrict Editing. Step 3: By turning off Restrict Editing, Word will ask for your password from you, and after you enter it, it will unprotect
your file. Part 3. Remove Password Protection for Editing from Word Documents without Knowing the Password Sometimes, people have sensitive information in a file but forget the password. If you're struggling with the same situation, here are some practical methods. Method 1: Saving the Word File as RTF Step 1: First, you need to convert your
Word file with an app that supports .rtf format files, such as Notepad or TextEdit. Step 2: Open the .rtf file and use the 'find-and-replace' tool to find 'passwordhash' and replace it with 'nopassword.' Step 3: Open the file with Microsoft Word, then click on the Review > Stop Protection. Step 4: In the pop-up window, uncheck all the boxes, change the
format back to .docx, and your Word document is unprotected. Method 2: Using WordPad to Save the Word Document Although the WordPad app isn't as glamorous as Microsoft Word, it can still help solve your problem. Step 1: Right-click on the document and select 'open with.' Click on 'choose another app' and select WordPad. Step 2: A window will
appear identical to the image below; click 'save a copy' and enjoy editing your word file without limitations. Method 3: Using Google Docs to Unprotect the Word Document Step 1: When using google docs to remove Word documents' passwords to edit, you must first log into your google account in your browser and then log into google docs at
docs.google.com. Step 2: Click on 'open file picker' and upload your word file in the next window. Step 3: After successfully uploading the file, you can download it without any password requirements. Method 4: Save the Word Document as a New File This method is also useful when you forget your password, and the file is only accessible in read-only
mode. Word documents protected by a password for modifying the file will show you a pop-up identical to the below image. Step 1: Click on the 'Read-only' button. Step 2: Afterward, save the file as another document with a new name, and from then on, the Word document will be unprotected and can be modified. Part 4. Remove Password from Full-
Locked Word Documents without Knowing the Password The documents you use are, more often than not, full-locked rather than read-only. You can use any of the four methods to deal with these files. Method 1: Use Word Document Password Removers There are many Word file password removers that you can use. The applications listed below are
among the most popular password removers and operate similarly. Passfab for Word This software is user-friendly and highly effective at removing all types of passwords from your Word document. It uses three different password recovery modes that target different passwords if you remember what type of characters you used in the password and a
brute force attack that removes all kinds of passwords but takes longer. Passper Word Password Recovery This software is identical to Passfab, except it is also available for macOS users. This article will use the Passper software and show you how to recover your password with this app. Step 1: Select the Word document you want to remove the
password. Step 2: After selecting the file, the app will give you three options, as shown below. Step 3: Here are the settings for brute-force with mask attack and dictionary attack. We recommend you go with a Brute-force attack since it does the job and doesn't require you to select various options in the setting. Step 4: In a matter of minutes, the



software will remove your Word document's password, and you can edit the file to your liking. Method 2: Renaming the Password Protected Word Document This method is somewhat lengthy, but it works just fine if you can't or don't have the time to do the other techniques. Step 1: Select your Word document and rename the extension from .docx to
.zip. Step 2: Open the new zip file with your zip tool. Step 3: Select the 'settings.xml' file and delete it. Step 4: Rename the extension to .docx; your file is no longer password protected. You can open and edit it to your liking. Method 3: Using VBA Code to Unprotect Your Word Document This method only works on .doc files and not .docx files. To change
the file format, you can easily follow the process we explained in the last method for changing the file format. Now, Let's see how this method works. Step 1: Open the Word document you need to unprotect. Step 2: Press ALT + F11 to open Visual Basic Editor. Step 3: In the new window, right-click on the file and select insert > module. Step 4: Copy the
following VBA code into your module. Sub PasswordBreaker() Dim i As Integer, j As Integer, k As Integer Dim 1 As Integer, m As Integer, n As Integer Dim il As Integer, i2 As Integer, i3 As Integer Dim i4 As Integer, i5 As Integer, i6 As Integer On Error Resume Next Fori = 65 To 66: For j = 65 To 66: For k = 65 To 66 For1l = 65 To 66: For m
= 65 To 66: Foril = 65 To 66 Fori2 = 65 To 66: For i3 = 65 To 66: Fori4 = 65 To 66 For i5 = 65 To 66: Fori6 = 65 To 66: Forn = 32 To 126 ActiveSheet.Unprotect Chr(i) & Chr(j) & Chr(k) & _ Chr(l) & Chr(m) & Chr(il) & Chr(i2) & Chr(i3) & _ Chr(i4) & Chr(i5) & Chr(i6) & Chr(n) If ActiveSheet.ProtectContents = False
Then MsgBox "Password is " & Chr(i) & Chr(j) & _ Chr(k) & Chr(l) & Chr(m) & Chr(il) & Chr(i2) & _ Chr(i3) & Chr(i4) & Chr(i5) & Chr(i6) & Chr(n) Exit Sub End If Next: Next: Next: Next: Next: Next Next: Next: Next: Next: Next: NextEnd Sub Step 5: Click 'run' and 'OK' in the new window. Step 6: Finally, you can
stop your Word file protection. Method 4: Using an Online Word Document Password Remover You only need to use online password removers when the document requires a password to open instead of needing it for modification. You can google 'online word password remover' and use any of the hundreds of results. Password remover tools such as
password-online.com or lostmypass.com are easy to use and usually succeed at cracking the password. All password recovery tools have a general process that includes selecting the file, selecting the approach (some online tools don't have different methods and only perform brute-force), and clicking 'start.' For this article, we will be using lostmypass.
Step 1: Drag and drop on the lostmypass home page and manually select the file you want to decrypt. Step 2: After you upload the Word file, lostmypass online password remover automatically starts decrypting it. Step 3: When the decryption is complete, the website will show you your password, and you can use it to remove the protection of your Word
document. Conclusion You can open Word documents that are password protected in different ways, both online and offline. The online methods will not always work, but they're worth a try. The techniques to remove password protection from word files when you don't know the password apply only to documents you have forgotten the password of. If
you have a document that is not yours and is protected, it's best not to try to open it as it's someone else's, and you're risking legal problems. Free Download For Windows XP/Vista/7/8/10/11 Free Download For macOS X 10.10 or later Microsoft Word ir pasaulé popularakais teksta dokumentu redaktors. Cilveki izmanto Word dokumentus, lai redigetu un
izplatitu ligumus, rakstus, juridiskus un citus dokumentus.Microsoft Word lauj aizsargat failu no nesankcionétu lietotaju atvérsanas. Vieniga persona, kas zina paroli, var skatit vai mainit jisu failu. Si aizsardziba nevar pilniba aizsargat failu no brutala spéka paroles uzbrukumiem, tapéc neaizmirstiet iestatit sareZgitas paroles, ko izveidojusi parolu
generatori. Microsoft Word atbalsta vairakus aizsardzibas limenus. Varat iestatit paroli, kas nepieciesama dokumenta apskatei (atvért failu). Varat ari iestatit atlaujas paroli, lai ierobeZotu noteiktas darbibas, pieméram, dokumenta redigé$anu, komenté$anu vai izmainu izsekosanu.S1 bezmaksas tie$saistes lietojumprogramma, kuras pamata ir GroupDocs
API, nonem Microsoft Word failu aizsardzibu ar paroli. Lai atblokéetu failu, jums ir janorada parole. Més augstu vertéjam jusu privatumu, tapéc fails un parole ir redzami tikai jums. Varat lejupieladéet neaizsargato failu, lai to atvertu. Lietojumprogramma darbojas jebkura ierice, ieskaitot viedtalrunus. Video pamaciba Download Article An in-depth guide to
unlock a Microsoft Word file Download Article The ability to password protect an MS Word document is a very useful feature. It helps to keep your documents private and manage shared access with several authorized users. However, if you lose the password, you will be left with a document you can’t open or edit at all. Learn more about what to do if
you forget or don't have access to the original password for documents in MS Word, as well as the steps for removing the password. Remove the password in File/Review (Mac) > Info (Windows only) > Protect Document > Encrypt with Password > Delete password > OK. It's difficult to regain access to a locked document without the password, but you
can try changing the extension name, editing the settings.xml file, or converting it to RTF. 1 Open the document and enter the password. This method is only useful if you remember the password but want to remove it so anyone can access it. 2 Click File and select Info. This will show you more options to edit the document in the panel on the right side
of the Word window. If you're using a Mac, click the Review tab instead. Advertisement 3 Click Protect Document. It's the first option next to an icon of a padlock and key. On Mac, find this in the "Protect" grouping. 4 Click Encrypt with Password. A little window pops up with your current password. Under the password field is a warning that losing or
forgetting this password means that your Word document is lost and cannot be recovered. This article covers a few options that might help you get back into this document, but a lost or forgotten password usually means the document is unretrievable. 5 Delete everything in the text box, and click OK. You want this box to be empty to remove any
passwords protecting it. Now anyone can open the document![1] The box turns yellow when there is a password in place. You'll know there is no password when it's not colored. Advertisement 1 Open the document and enter the password. This method is only useful if you remember the password but want to remove it so anyone can access it. 2 Click the
Review tab. It's in the editing ribbon above the document. 3 Click Protect Document. Find this in the "Protect" grouping. Another window will open; look for the "Security" section. Under the password field is a warning that losing or forgetting this password means that your Word document is lost and cannot be recovered. This article goes over a few
options that might help you get back into this document, but a lost or forgotten password usually means the document is unretrievable. 4 Delete everything in the text box, and click OK. You want this box to be empty to remove any passwords protecting it. Now anyone can open the document![2] The box turns yellow when there is a password in place.
You'll know there is no password when it's not colored. Advertisement 1 Rename the file to change its extension.- This is highly unreliable and may not work for you, but it is something you can try. Here's what to do: Open File Explorer and navigate to your .doc or .docx file. Right-click it and select Rename. Delete the .doc or .docx extension and enter
.zip. Press Enter after changing the file extension. A confirmation window will appear. Click Yes in the pop-up window to confirm the file name change. If you have a .docx extension, and following this method doesn't work, try again and put the ".zip" extension after the .docx extension so it looks like this: .docx.zip. 2 Open the .zip file. You can double-
click to open it or right-click it and select Open in new window. 3 Double-click the Word folder. You'll see more files, including a file called "settings.xml." 4 Delete the settings.xml file. Right-click the file name and select Delete, or click it once and click the trashcan icon in the toolbar.[3] Advertisement 1 Rename the file to change its extension.- This is
highly unreliable and may not work for you, but it is something you can try. Here's what to do: Open your file manager (Finder for Mac or File Explorer for Windows) and navigate to your .doc or .docx file. Right-click or control-click it and select Rename. Delete the .doc or .docx extension and enter .zip. Press Enter after changing the file extension. A
confirmation window will appear. Click Yes in the pop-up window to confirm the file name change. If you have a .docx extension, and following this method doesn't work, try again and put the ".zip" extension after the .docx extension so it looks like this: .docx.zip. This is highly unreliable and may not work for you, but it is something you can try. This
helped in the case of a Mac user who was unable to get rid of the password-protected feature that was preventing auto-saves.[4] 2 Open the .zip file. You can double-click to open it or right-click it and select Open in new window. 3 Double-click the Word folder. You'll see more files, including a file called "settings.xml." 4 Drag the file outside the Word
folder. For example, drag it to your desktop. This way, you can edit it directly, and it's not protected by the Word folder. 5 Open the document and search for enforcement. If you right-click on the XML file, you can choose to open it in Notepad on Windows, or TextEdit for macOS. Press Ctrl + F to quickly find the term "enforcement." You'll see a 1 after
"enforcement" in the XML file. 6 Change the "1" to a "0," and save the XML file. You can save it to write over the original file. 7 Put the file back into the Word folder and rename it to .docx again. You can drag and drop the file back into the Word folder, right-click the overall folder, which is your original Word document, and rename it to have the .docx
file extension again. The document will no longer be password protected whenever you try to open it. Advertisement 1 Open the document in Word and save it as an RTF file. This only helps as long as you can open the document. To do this, follow these steps: Open the document in Word and go to File > Save as. Change the "File Type" to Rich Text
Format (.rtf) and save it. 2 Open the .rtf file in Notepad. You can also use any other plain text editor. Do this by right-clicking the file in your file manager and selecting Open with > Notepad. 3 Replace passwordhash with nopassword and save it. Press Ctrl + F to pull up the Finder to easily search for "passwordhash". Erase that term and replace it with
"nopassword." Press Ctrl + S to save the document. 4 Open the document in Word and remove the password. Once you've made the changes in Notepad or the general text editor of your choice, you can re-open it in Word to remove any lingering protections. The password is gone, so you can open it without any issue.[5] To open your document in Word,
you have two options: Open Word, go to Open, and select your document. Double-click your document or right-click it and select Open with > Word. Advertisement Ask a Question Advertisement Thanks Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Darlene Antonelli, MA. Darlene has been
writing and editing tech content at wikiHow since 2019. She previously worked for AppleCare, served as a writing tutor, volunteered in IT at an animal rescue, and taught as an adjunct professor for EN101 and EN102. Darlene has completed Coursera courses on technology, writing, and language. She holds both a BA (2011) and an MA (2012) from
Rowan University in Writing, with a focus on workplace communication. With her extensive experience, academic background, and ongoing learning, Darlene has become the go-to grammar expert for her friends and family, as well as a skilled wordsmith for anyone in need. This article has been viewed 436,779 times. Co-authors: 12 Updated: May 28,
2025 Views: 436,779 Categories: Microsoft Office Print Send fan mail to authors Thanks to all authors for creating a page that has been read 436,779 times. Microsoft Word je celosvetovo najpopularnejsi editor textovych dokumentov. Ludia pouzivaju dokumenty programu Word na upravu a distribtciu zmlav, ¢lankov, pravnych a inych
dokumentov.Microsoft Word umozinuje chranit sibor pred otvorenim neopravnenymi pouzivatelmi. Iba osoba, ktord pozna heslo, mo6ze zobrazit alebo upravit vas sibor. Tato ochrana neméze uplne zabezpecit sibor pred itokmi hrubou silou hesiel, takze nezabudnite nastavit zlozité hesla vytvorené generatormi hesiel. Microsoft Word podporuje niekolko
arovni ochrany. MoZete nastavit heslo potrebné na zobrazenie dokumentu (otvorenie siboru). Mézete tiez nastavit heslo povolenia na obmedzenie konkrétnych akcii, ako je uprava dokumentu, komentovanie alebo sledovanie zmien.Tato bezplatnd online aplikacia zaloZena na GroupDocs API odstranuje ochranu stuborov Microsoft Word heslom. Na
odomknutie siboru musite zadat heslo. Cenime si vaSe sukromie, takze stbor a heslo vidite iba vy. Ak chcete otvorit nechraneny sibor, mézete si ho stiahnut. Aplikacia funguje na akomkolvek zariadeni vratane smartféonov. Video tutoridl Microsoft Word is 's werelds populairste editor voor tekstdocumenten. Mensen gebruiken Word-documenten om
contracten, artikelen, juridische en andere documenten te bewerken en te verspreiden.Met Microsoft Word kan een bestand worden beschermd tegen openen door onbevoegde gebruikers. De enige persoon die het wachtwoord kent, kan uw bestand inzien of wijzigen. Deze bescherming kan het bestand niet volledig beveiligen tegen brute-force
wachtwoordaanvallen, dus vergeet niet om complexe wachtwoorden in te stellen die zijn gemaakt door wachtwoordgeneratoren. Microsoft Word ondersteunt verschillende beschermingsniveaus. U kunt het wachtwoord instellen dat nodig is om het document te bekijken (het bestand openen). U kunt ook een machtigingswachtwoord instellen om
specifieke acties te beperken, zoals het bewerken van een document, het plaatsen van opmerkingen of het bijhouden van wijzigingen.Deze gratis online applicatie op basis van de GroupDocs API verwijdert de wachtwoordbeveiliging van Microsoft Word-bestanden. U moet het wachtwoord opgeven om het bestand te ontgrendelen. We hechten veel
waarde aan uw privacy, dus het bestand en het wachtwoord zijn alleen voor u zichtbaar. U kunt het onbeveiligde bestand downloaden om het te openen. De applicatie werkt op elk apparaat, ook op smartphones. Video uitleg Online Word Password Remover is a web-based tool designed to help users unlock password-protected Microsoft Word documents
without the need for installing software. Whether the file is protected from opening or editing, this tool can attempt to remove the restrictions and provide full access to the content. It supports both .doc and .docx formats, making it compatible with all modern and older versions of Word. Users simply upload the locked file, and the system processes it
automatically. It’s an ideal solution for individuals who have forgotten a password or received a secured document without knowing the credentials.The main advantage of using an online Word password remover is its convenience and cross-platform accessibility. Since it operates entirely in the cloud, there’s no need for downloads, and it works on
Windows, macOS, Linux, and even mobile browsers. Online Word Password Remover also uses secure, encrypted connections and deletes uploaded files shortly after processing to ensure user privacy.
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